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Interactive Computing Series

GOALS/PHILOSOPHY

The Interactive Computing Series provides you with an illustrated interactive
environment for learning software skills using Microsoft Office. The text uses both “hands-on”
nstruction, supplementary text, and independent exercises to enrich the learning experience.

APPROACH

The Interactive Computing Series is the visual interactive way to develop and apply soft-
ware skills. This skills-based approach coupled wath its highly visual, two-page spread design
allows the student to focus on a single skill without having to turn the page. A Lesson Goal at
the beginning of each lesson prepares the student to apply the skills with a real-world focus.
The Quiz and Interactivity sections at the end of each lesson measure the student’s under-
standing of the concepts and skills learned in the two-page spreads and reinforce the skills with
additional exercises.

ABOUT THE BOOK

The Interactive Computing Series offers fwo levels of instruction. Each level builds upon
the previous level.

Brief lab manual covers the basics of the application, contains two to four chapters.

Introductory lab manual—includes the material in the Brief textbook plus two to four
additional chapters. The Introductory lab manuals prepare students for the Microsofi Office User
Specialist Proficiency Exam (MOUS Certification).

Each lesson is divided into a number of Skills. Each Skill is first explained at the top of the
page in the Concept. Each Concept is a concise description of why the Skill is useful and
where it is commonly used. Each Step (Do It!) contains the instructions on how to complete
the Skill. The appearance of the Mous skifl icon on a Skill page indicates that the Skill contains
instruction in at least one of the required MOUS objectives for the relevant exam. Though the
icons appear in the Brief manuals as well as the Introductory manuals, only the Introductory
manuals may be used in preparation for MOUS Certification.



InformationTechnology

Information Technology at
McGraww-Hill/lrwin

At McGraw-Hill Higher Education, we publish instructional materials targeted at the
higher education market. In an effort to expand the tools of higher learning, we publish
texts, lab manuals, study guides, testing materials, software, and multimedia products.

At McGraw-Hill/Irwin (a division of McGraw-Hill Higher Education), we realize that
technology has created and will continue to create new mediums for professors and stu-
dents to use in managing resources and communicating information with one another.
We strive to provide the most flexible and complete teaching and learning tools available
as well as offer solutions to the changing world of teaching and learning

MCGRAW-HILL/IRWIN IS DEDICATED TO PROVIDING THE TOOLS
FOR TODAY’'S INSTRUCTORS AND STUDENTS TO SUCCESSFULLY
NAVIGATE THE WORLD OF INFORMATION TECHNOLOGY.

® Seminar series—Technology Connection seminar series offered across the
country every year demonstrates the latest technology products and encourages col-
laboration among teaching professionals.

® Osborne/McGraw-Hill—This division of The McGraw-Hill Companies is
known for its best-selling Internet titles: Harley Hahn’s Internet & Web Yellow
Pages, and the Internet Complete Reference. Osborne offers an additional resource
for certification and has strategic publishing relationships with corporations such as
Corel Corporation and America Online. For more information visit Osborne at
www.osborne.com.

¢ Digital solutions— McGraw-Hill/Irwin is committed to publishing digital solu-
tions. Taking your course online does not have to be a solitary venture, nor does it
have to be a difficult one. We offer several solutions that will allow you to enjoy all
the benefits of having course material online. For more information visit
www.mhhe.com/solutions/index.mhtml.

* Packaging options— For more about our discount options, contact your local
McGraw-Hill/Irwin Sales representative at 1-800-338-3987 or visit our Web site at
www.mhhe.com/it.
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Figure 1

Skill: Each lesson
is divided into a
number of specific

skills

Concept: A concise
description of why
the skill is useful
and when it is
commonly used

Do It!: Step-by-step
directions show
you how to use

the skill in a real-
world scenario

Hot Tips: Icons
introduce helpful

Finding and Replacing
Text

skill

concept

The Find command enables you to search a document for individual occurrences of any word,
phrase, or other unit of text. The Replace command enables you to replace one or all occur-
rences of a word that you have found. Together, the Find and Replace commands form power-
ful editing tools for making many document-wide changes in just seconds.

- ' Use Find and Replace to spell a word consistently throughout a document.
U '[ 1. Open student file, wddoit12.doc, and save it as Report2.doc.
2. If necessary, place the insertion point at the beginning of the document. Word will search

the document from the insertion point forward.

3. Click Edit, and then click Replace. The Find and Replace dialog box appears with the
Replace tab in front and the insertion point in the Find What text box.

4. In the Find What box, type the two words per cent. Click in the Replace With box, and
type the one word percent (see Figure 3-37).

8 1 (o search the document for all instances of per cent and to replace them
with pereent. A message box appears to display the results. In this case, one replacement
was made (see Figure-3-3ob- Q@ In short documents the Find and Replace procedure

hints or trouble-

More: Provides in-
depth information
about the skill and

related features

shooting tips

takes so little time that you usually cannot cancel it before it ends. However, in longer
documents you can cancel a search in progress by pressing [Fsc|.

6 Click -
dialog box.

d 10 close the message box. Click ! to close the Find and Replace

7. Save and close the document, Reportl2.doc, with your change.

Clicking the Replace All button in the Find and Replace dialog box replaces every instance of the text you
m U re have placed in the Find What box. To examine and replace a word or phrase manually instead of automat-

ically, start by clicking the Find Next button. If you desire to replace that instance, click the Replace but-
ton. Continue checking the document like this, clicking the Find Next button and then, if desired, the Replace button. Keep
clicking the pairs of buttons until you have run through the entire document. Unless you absolutely must do otherwise, use the
method for shorter documents only.

The first button under the Replace With box usually displays the word More. Click this button when you want to display the
the Search Options area of the dialog box. With the area displayed, the More button converts (0 a Less button. Clicking on the
Less button will hide the Search Options arca. The Scarch drop-down list under Search Options determines the direction of the
search relative (o the insertion point. You can search upward or downward through the document or keep the Word default set-
ting of All to check the whole document, including headers, footers, and footnotes. The Format drop-down list enables you to
search criteria for fonts, paragraphs, tabs, and similar items. The Special drop-down list enables you to search for paragraph
marks, tab characters, column breaks and related special characters. The No Formatting button removes all formatting criteria
from searches. For information on the Search Option activated by the check boxes, consult Table 3-3.

The Find tab of the Find and Replace dialog box matches the Replace tab except it lacks the replace function and only searches
documents for items that you specily.

In the book, each skill is described in a two-page graphical spread (Iigure 1). The left side of the
two-page spread describes the skill, the concept, and the steps needed to perform the skill. The
right side of the spread uses screen shots to show you how the screen should look at key stages.



Figure 1 (cont'd)

COMPUTING

Figure 3-37 Find and Replace dialog box

Enter the word or Find and He

phrase to search for
and replace here

Enter the replacement
word here

Click to determine
direction of search

Use check boxes to
activate search
options

-
Telecommuting jobs typically consist of writing, research, data processing, performing

Find and Replace
makes one change
in document

numerical calculations, or other tasks that telecommuters can accomplish regardless of their

&
locatien, Telecommuters may perform part or all of their work away from their offices. By the

end of 1995, there w

million telecommuters in the United States. Because of the changing

nature of work and the growing

some

experts predict that telecommuters will comprise 20 percent of the U.S. work force within 15

Table 3-3 Search Options
Option Description
Match case Finds those items in capitals and/or lowercase that exactly match contents of Find What box

Find whole words only Finds only those items that are whale words, not parts of a larger word

Use wildcards Searches for wildcards, special characters, or special search operators found in Find What box
Sounds like Finds words that sound the same as in Find What box but are spelled differently
Find all word forms Replaces all forms of the text in Find What box with proper forms of the word in the Replace

with box; words in both boxes should be the same part of speech

Practice

END-OF-LESSON FEATURE S

In the book, the learning in each lesson is reinforced at the end by a Quiz and a skills review
called Interactivity, which provides step-by-step exercises and real-world problems for the students

to solve independently.

saimea)

Screen shots:
Show you what the
screen should look
like after following
the Do It! steps

Summary tables:
Give you a quick
overview of
shortcuts, toolbar
buttons, and options
you can use to
complete the skill

Practice: Allows
you to practice the

— skill with a built-in

exercise or directs
you to a student file




Digital Solutions (continued)

OLC/Series Web Sites—Online Learning Centers (OLCs)/Series Sites are accessible
through our Supersite at www.mhhe.com/it. Our Online Learning Centers/ Series Sites
provide pedagogical features and supplements for our titles online. Students can point
and click their way to key terms, learning objectives, chapter overviews, PowerPoint
slides, exercises, and Web links.

The McGraw-Hill Learning Architecture (MHLA)—is a complete course delivery sys-
tem. MHLA gives professors ownership in the way digital content is presented to the
class through online quizzing, student collaboration, course administration, and content
management. For a walk-through of MHLA visit the MHLA Web site at www.mhla.net.

Packaging OptionS¥For more about our discount options, contact your local McGraw-
Hill/Irwin Sales representative at 1-800-338-3987 or visit our Web site at www.mhhe.com/it.

Visit www.mhhe.com/it

THE ONLY SITE WITH ALL YOUR CIT AND MIS NEEDS.

(Panunuoa) Saamosal fuiyaea)
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The Interactive Computing Series is a cooperative effort of many individuals, cach con-
tributing to an overall team effort. The Interactive Computing team is composed of
instructional designers, writers, multimedia designers, graphic artists, and program-
mers. Our goal is to provide you and your instructor with the most powerful and enjoy-
able learning environment using both traditional text and interactive techniques.
Interactive Computing is tested rigorously prior to publication.

Our special thanks to George Werthman, our Publisher; Sarah Wood, our
Developmental Editor; and Jeffrey Parr, Marketing Director for Computer Information
Systems. They have provided exceptional market awareness and understanding, along
with enthusiasm and support for the project, and have inspired us all to work closely
together. In addition, Steven Schuetz provided valuable technical review of our interac-
tive versions, and Charles Pelto contributed superb quality assurance.

The Azimuth team members who contributed to the Interactive ( ompuling Sertes are:

Ken Rosenblatt (Editorial Director, Writer)
Russell Polo (Technical Director)

Robin Pickering (Developmental Editor, Writer)
David Langley (Writer)

Chris Hahnenberger (Multimedia Designer)
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The following is a list of supplemental material available with the Interactive Computing Series:

Skills Assessment

SimNet eXPert (Simulated Network Assessment Product)—SimNet provides a way for you to test
students’ software skills in a simulated environment. SimNet is available for Microsoft Office 97,
Microsoft Office 2000, and Microsoft Office XP. SimNet provides flexibility for you in your
course by offering:

* Pre-testing options

* Post-testing options

¢ Course placement testing

* Diagnostic capabilities to reinforce skills

* Proficiency testing to measure skills

* Web or LAN delivery of tests

» Computer based training materials (New for Office XP)
* MOUS preparation exams

* Learning verification reports

* Spanish Version

Instructor’s Resource Kits

The Instructor’s Resource Kit provides professors with all of the ancillary material needed to
teach a course. McGraw-Hill/Irwin is dedicated to providing instructors with the most effective
instruction resources available. Many of these resources are available at our Information
Technology Supersite www.mhhe.com/it. Our Instructor’s Kits are available on CD-ROM and
contain the following:

Diploma by Brownstone—is the most flexible, powerful, and easy-to-use computerized
testing system available in higher education. The diploma system allows professors to
create an Exam as a printed version, as a LAN-based Online version, and as an Internet
version. Diploma includes grade book features, which automate the entire testing
process.

Instructor’s Manual—Includes:

—Solutions to all lessons and end-of-unit material
—Teaching Tips

—Teaching Strategies

—Additional exercises

PowerPoint Slides—NEW to the Interactive Computing Series, all of the figures from the
application textbooks are available in PowerPoint slides for presentation purposes.

Student Data Files—To use the Interactive Computing Series, students must have Student
Data Files to complete practice and test sessions. The instructor and students using this
text in classes are granted the right to post the student files on any network or stand-
alone computer, or to distribute the files on individual diskettes. The student files may
be downloaded from our I'T Supersite at www.mhhe.com/it.

Series Web Site—-Auvailable at www.mhhe.com/cit/apps/laudon.
Digital Solutions

Pageout—is our Course Web site Development Center. Pageout offers a Syllabus page, Web site
address, Online Learning Center Content, online exercises and quizzes, gradebook, discussion
board, an area for students to build their own Web pages, and all the features of Pageout Lite.
For more information please visit the Pageout Web site at www.mhla.net/pageout.
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Developing Your Presentation

Editing and Adding Text Boxes ®
Formatting Text @

Moving Text Boxes and Aligning Text®
Using the Spelling Checker

Finding and Replacing Text

Using AutoCorrect

Drawing and Formatting Objects®
Modifying and Enhancing Drawn Objects
Printing Audience Handouts

Saving Slide Presentations as RTF Files
Shortcuts

Quiz

Interactivity

Strengthening Your
Presentation

Adding Clip Art®

Editing Clip Art

Inserting a Picture from a File
Inserting a Chart ®

Customizing the Datasheet
Changing a Chart’s Type

Setting Chart Options
Formatting Chart Elements
Adding Transition Effects
Timing Slide Transitions
Annotating Slides

Navigating during a Slide Show ®
Shortcuts

Quiz

Interactivity
Glossary

Index

File Directory

PP 3.1

PP 3.2

PP 3.6
PP 3.10
PP 3.12
PP 3.14
PP 3.16
PP 3.18
PP 3.22
PP 3.24
PP 3.26
PP 3.28
PP 3.29
PP 3.31

PP 4.1

PP 4.2

PP 4.4

PP 4.8
PP 4.10
PP 4.12
PP 4.14
PP 4.16
PP 4.18
PP 4.22
PP 4.26
PP 4.28
PP 4.30
PP 4.32
PP 4.33
PP 4.35

PP 1

PP 11

PP 13

® Skill covers at least one MOUS Certification Core objective.
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PowerPoint 2002 st eior

Preface

Introduction to PowerPoint

Introducing PowerPoint and Presentation Design
Starting PowerPoint

Using the AutoContent Wizard ®

Exploring the PowerPoint Window

Viewing Your Presentation

Saving and Closing a File ®

Using the Office Assistant

Other PowerPoint Help Features

Shortcuts

Quiz

Interactivity

Designing Your Presentation

Opening a New Presentation

Opening an Existing PowerPoint File
Entering Text in Normal View

Adding a New Slide to Your Presentation ®
Working with Text on the Outline Tab
Adding Speaker’s Notes

Printing Slides and Notes Pages @
Shortcuts

Quiz

Interactivity

PP 1.1

PP 1.2
PP 1.4
PP 1.6
PP 1.10
PP 1.14
PP 1.16
PP 1.20
PP 1.22
PP 1.24
PP 1.25
PP 1.27

PP 2.1

PP 2.2
PP2.4
PP 2.6
PP 2.8
PP 2.10
PP 2.14
PP2.16
PP 2.18
PP 2.19
PP 2.21

@ Skill covers at least one MOUS Certification Core objective.

Xv
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Introduction to PowerPoint

skills

Introducing
PowerPoint and
Presentation Design

Starting PowerPoint

Using the
AutoContent Wizard

Exploring the
PowerPoint Window

Viewing Your
Presentation

Saving and Closing a
File

Using the Office
Assistant

Other PowerPoint
Help Features

Microsoft PowerPoint is a computer application that helps you create professional-
looking presentations. With PowerPoint you can make on-screen presentations, over-
head transparencies in black and white or color, paper printouts, 35mm slides, or
handouts that include notes or outlines of your presentation. You even can publish a
PowerPoint presentation on the World Wide Web where anyone with Internet service
and a Web browser can view it. PowerPoint is an effective tool that enables you to
organize and present information easily. Creating and editing text and graphics are
made easier by PowerPoint’s user-friendly features.

With PowerPoint you can design a presentation using a pre-made template—that is, a
file with a pre-existing layout, background colors, fonts and bullets of certain sizes,
and so on. If you do not use a template, you can create your own presentation from
blank slides. A quick and easy way to create a presentation is to let PowerPoint aid
you in designing one by using a tool called the AutoContent Wizard. PowerPoint
enables you to add Clip Art, charts, photographs, video, and sound to enhance your
presentation.

If you need help on how to use PowerPoint, you can ask questions of the Office
Assistant or enter them in the Ask a Question box to receive tips and/or Help topics
potentially related to your questions. An extensive Help facility complements the
Assistant and Question box. This facility has additional tabs for displaying and print-
ing information from either the program’s built-in database of Help topics or from
Microsoft’s Web-based Help sites.

Lesson Goal:

-
)
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o
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)
s
>
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N

Start PowerPoint and familiarize yourself with the application by creating a short pre-
sentation using the AutoContent Wizard. Also use PowerPoint’s key Help features to
obtain assistance.
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Introducing PowerPoint
and Presentation Design

A PowerPoint presentation is a file composed of slides, each slide being a single screen of the
presentation. You can create overhead transparencies and other presentation materials contain-
ing main headings and subpoints. You can use simple graphics like Clip Art or photographs to
complement your text or more complicated graphics like tables, charts, or diagrams to illus-
trate complex ideas or data. If you display a presentation on a computer, not just an overhead
projector, you can exploit PowerPoint’s increasingly powerful animation features to create
dynamic presentations rivaling television and the movies. As mentioned on the previous page,
you even can publish PowerPoint presentations to the World Wide Web.

Teachers and students alike use PowerPoint to explore every subject from art to English to
math to zoology. Business professionals use PowerPoint to create simple handouts or com-
plex presentations on acquiring other companies, marketing products to consumers, building
new facilities, and so on. PowerPoint presentations are popular with non-profit organizations,
social and political clubs, and the military and government as well.

Building a PowerPoint presentation involves starting with a basic design, adding new slides
and content, then modifying slide design, often with different formats and color schemes. As
suggested above, computer-based presentations often contain additional slide transitions, ani-
mation, sound effects, and narration. The four bullet points below explain the most common
ways in which people build presentations:

@ With a Blank presentation you must add all of the background elements, text, graphics,
and other visual elements people normally associate with professional-looking
presentations.

@ With a Design Template you begin with a file containing a pre-selected background com-
plete with a color scheme, placeholders dictating the location and size of text and/or
graphics, fonts and bullets of pre-determined sizes, and other formatting elements common
to finished presentations. You can apply this template to all of your slides or to just select-
ed slides. With PowerPoint 2002, you also now have the freedom to apply more than one
type of template within a presentation.

@ With a Content Template you begin with a design template as described above. However,
this template also contains suggested text for each slide to help you stay focused on the
purpose and content of your presentation. By replacing the suggested text with your own,
you stay on topic but have a presentation that is custom designed for your own situation.
The AutoContent Wizard, discussed later in this Lesson, uses Content Templates.

@ With a Web Template you begin with a template stored on a Web site, such as the
Microsoft Office Template Gallery at http://officeupdate. microsoft.com/templategallery/.
Web designers, graphic artists, and other Internet-trained users provide categorized
PowerPoint templates on their sites, sometimes for free and sometimes for a fee.You can
access these Web sites from within an Internet browser or directly through PowerPoint.




Figure 1-1 Sample Title slide

Title slides summarize
presentation topic, grab
viewer’s attention, and
list key upcoming points
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Figure 1-3 Multiple slides created with AutoContent Wizard
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s kl I I Starting PowerPoint

start PowerPoint and other programs by using the Start menu on the Windows taskbar, a
Quick Launch on the Windows taskbar, a desktop shortcut, or by finding the program’s exe-
cutable file through My Computer or Windows Explorer.

To use PowerPoint, you first must start the application from your computer’s desktop. The
E U n E E D Windows operating system permits you to start an application in a variety of ways. You can

" Begin using PowerPoint by starting the application from the Start menu.
U It ' 1. Turn on your computer and monitor. After a brief delay the Windows Desktop will appear
) (generally with a greenish background). Shortcuts (images with program names under-
neath them) will appear on the Desktop for accessing the main utility and application pro-
grams in your computer’s hard drive or on your organization’s network. A gray Windows
taskbar will appear at the-bottom of the screen. Click the Start button located at
the left end of the taskbar. A gray Windows Start menu will appear above the button.

2. On the Start menu, move the mouse pointer over the word Programs to select it near the
top of the menu. The gray Programs submenu will appear with, generally, an alphabetized
list of programsthat.are installed on your computer.

3. After pointing to the word Programs, slide over to select the Programs submenu and then
down to select the words Microsoft PowerPoint (see Figure 1-4).

4. With Microsoft PowerPoint still selected, click the left mouse button to start the program.
By default, PowerPoint will display the Normal view of the application with the Outline
and Slides tabs at the left side of the program window, a blank slide in the middle Slide
Pane of the window, and the New Presentation task pane at the right side of the window.
(see Figure 1-5).

5. Do not worry if your program window does not exactly resemble Figure 1-5. Users can
install PowerPoint in more than one way, and the Microsoft Windows environment comes
in more than one version. The actions of previous users also may affect the setup of your
program window. o To make a consistent view appear each time you open
PowerPoint, click the Tools menu near the top of the screen, click Options to open the
Options dialog box, and click the View tab if needed to bring it to the front of the dialog
box. Under the Default View section of the View tab, click the down-pointing arrow, click
the option Normal - thumbnails, notes and slide, then click the OK button | |

6. The next Skill introduces the AutoContent Wizard, which appears in the New Presentation
Task Pane under the category New. Therefore, leave the file open.

you to record speaker notes for the current slide on the screen. For example, for the opening slide of

a presentation, you might type welcoming remarks in the pane, and for a concluding slide you might
suggest follow-up actions for your audience to undertake after leaving a meeting. After preparing a presentation, you can
print regular handouts, transparencies, or similar items for your audience but print Notes pages for yourself as the presen-
ter. Later Skills will discuss printing various versions of a presentation.

m U I'e Notice also that a Notes Pane appears below the blank slide. Clicking and typing in this pane enables



